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Abstract

These Application Notes describe the procedures for configuring Telecom Liechtenstein
Session Initiation Protocol (SIP) Trunking with Avaya IP Office Release 10 and Avaya
Session Border Controller for Enterprise Release 7.1.

Telecom Liechtenstein SIP Trunking provides PSTN access via a SIP trunk between the
enterprise and the Liechtenstein network as an alternative to legacy analog or digital trunks.
This approach generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Telecom Liechtenstein is a member of the Avaya DevConnect Service Provider program. .
Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. . Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between service provider Telecom Liechtenstein (Liechtenstein) and the Avaya IP Office
solution. In the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office
Server Edition release 10, Avaya Session Border Controller for Enterprise release 7.1 (Avaya
SBCE), Avaya Voicemail Pro, Avaya Communicator for Windows, and Avaya H.323, SIP, digital,
and analog endpoints.

The Telecom Liechtenstein SIP Trunking service referenced within these Application Notes is
designed for business customers. The service enables local long distance and international PSTN
calling via standards-based SIP trunks as an alternative to legacy analog or digital trunks, without the
need for additional TDM enterprise gateways and the associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to Telecom Liechtenstein SIP Trunking service via the Avaya SBCE. This configuration
(shown in Figure 1) was used to exercise the features and functionality tests listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. . The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office was connected to Liechtenstein SIP Trunking
service via the Avaya SBCE. To verify SIP trunking interoperability, the following features and
functionality were exercised during the interoperability compliance test:

e Response to SIP OPTIONS queries.

e SIP trunk registration and authentication.

e Incoming PSTN calls to various phone types. Phone types included H.323, SIP, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included H.323, SIP, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

e Inbound and outbound long holding time call stability.

e Various call types including: local, long distance, international, outbound toll-free, operator
service and directory assistance.

e Codec G.711A and G.729.

e (Caller number/ID presentation.
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e Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

e DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, and conference.

Fax G.711 Pass Through modes.

Off-net call forwarding.

Twinning to mobile phones on inbound calls.

Avaya Communicator for Windows.

Avaya Communicator for Web client (WebRTC).

Remote Worker which allows Avaya SIP endpoints to connect directly to the public Internet as
enterprise phones.

Note:

Remote Worker and Avaya Communicator for Web (WebRTC) were tested as part of this solution.
The configuration necessary to support remote worker and Avaya Communicator for Web is beyond
the scope of these Application Notes and are not included in these Application Notes. For these
configuration details, see Reference [8] and [9].

2.2. Test Results

Liechtenstein SIP Trunking passed compliance testing.

Items supported or not tested included the following:
e Fax T.38 is not supported by Liechtenstein system.

Interoperability testing of Liechtenstein SIP Trunking was completed with successful results for all
test cases with the exception of the observations/limitations described below.

e Call Redirection (Blind and Consultative Transfer) Using re-INVITE Method —
Inbound PSTN call to Avaya IP Office endpoints being transferred off-net to another PSTN
endpoint resulting in no ring back tone and no audio path. This issue caused by Avaya SBCE
did not forward the 2000K, responding to INVITE of second call leg, from service provider
to IP Office. This issue was resolved by applying Avaya SBCE hot-fix patch; sbce-7.1.0.1-
07-12090-hotfix-12062016. This hot-fix patch will also be integrated into Avaya IP Office
service update, SP2.

e Call Redirection (Call Forward Off-Net) Using REFER Method — Inbound call from
PSTN to IP Office endpoints got forwarded off-net to another PSTN, IP Office system
responded to NOTFIY (Trying) with 405 Method Not Allowed instead of 2000K. There
was no user impacted. The call was forwarded successfully with 2 ways audio.

e Call Redirection (Blind Transfer) Using REFER Method on H.323 Endpoint —
Inbound/outbound calls from/to PSTN to/from IP Office H.323 endpoint got transferred
to/from another PSTN, Liechtenstein system responded to second call leg INVITE with 480
Request Terminated to terminate the call instead of a BYE. There was no user impacted. The
call was transferred successfully with 2 ways audio.

e Call Redirection (Blind Transfer) Using REFER Method on SIP Endpoint —
Inbound/outbound calls from/to PSTN to/from IP Office SIP endpoint got transferred
to/from another PSTN, IP Office system responded to NOTFIY (Trying) with 405 Method
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Not Allowed instead of 2000K. There was no user impacted. The call was transferred
successfully with 2 ways audio.

e Call Redirection (Consultative Transfer) Using REFER Method on H.323 Endpoint —
Inbound/outbound calls from/to PSTN to/from IP Office H.323 endpoint got transferred
to/from another PSTN, IP Office system responded to NOTFIY (Trying) with 405 Method
Not Allowed instead of 2000K. There was no user impacted. The call was transferred
successfully with 2 ways audio.

e Call Redirection (Consultative Transfer) Using REFER Method on SIP Endpoint —
Inbound/outbound calls from/to PSTN to/from IP Office H.323 endpoint got transferred
to/from another PSTN, IP Office system responded to NOTFIY (Trying) with 405 Method
Not Allowed instead of 2000K. The SIP endpoint displayed transferred failed. The call was
transferred successfully with 2 ways audio.

e Call Redirection (Consultative Transfer) Using REFER Method on Avaya
Communicator for Windows (ACW)- Inbound/outbound calls from/to PSTN to/from IP
Office ACW endpoint got transferred to/from another PSTN, IP Office system responded to
NOTFIY (Trying) with 405 Method Not Allowed instead of 2000K. The SIP endpoint
displayed transferred failed. The call was transferred successfully with 2 ways audio.

e Call Redirection (Blind Transfer) Using REFER Method on Avaya Communicator for
Web (WebRTC) — Inbound/outbound calls from/to PSTN to/from IP Office WebRTC
endpoint got transferred to/from another PSTN, IP Office system responded to NOTFIY
(Trying) with 405 Method Not Allowed instead of 2000K. The SIP endpoint displayed
transferred failed. The call was transferred successfully with 2 ways audio.

2.3. Support

For technical support on the Avaya products described in these Application Notes, visit
http://support.avaya.com.

For technical support on Liechtenstein SIP Trunking, contact Liechtenstein at
http://www.telecom.li/de

3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to the Liechtenstein SIP Trunking service via the Avaya SBCE through the public IP
network. For confidentiality and privacy purposes, actual public IP addresses used in this testing
have been masked out and replaced with fictitious IP addresses throughout the document.

Located at the enterprise site is an Avaya IP Office Server Edition with the Avaya IP 500 V2
Expansion System which provides connections for 16 digital stations and the extension PHONE 8§
card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(Voice Compression Module) for supporting VoIP codecs. The LAN port of Avaya IP Office is
connected to the enterprise LAN while the WAN port is connected to the public IP network via
Avaya SBCE. Endpoints include an Avaya 9600 Series IP Telephone (with H.323 firmware), Avaya
11x0 Series IP Telephone (with SIP firmware), an Avaya 9508 Digital Telephone, an Avaya
Symphony 2000 Analog Telephone and an Avaya Communicator for Windows. A separate
Windows PC runs Avaya IP Office Manager to configure and administer the Avaya IP Office.
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Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user
phones will also ring and can be answered at the configured mobile phones.

Telecom Liechtenstein AG
SIP Trunking Services
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PSTN Phon%
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Figure 1: Test Configuration for Avaya IP Office with Liechtenstein SIP Trunking Service

For the purposes of the compliance test, this testing used Convoip Trunk FL (in Europe). For
outbound call from Avaya system to PSTN, user dialed 6 following by 00 and 11 digits including a 1
(Canada/US country code) since the testing was performed in North America (Canada). The test was
used 00 plus the 11 digits number (i.e. 6 001 613 967 5204). For inbound call to Avaya system from
PSTN, user dialed international call beginning with 011 plus 10 digits number provided by
Liechtenstein (011 423 237 2780).
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment Release
Avaya IP Office Server Edition 10.0.01.0 build 53
Avaya [P Office 500v2 (Expansion) 10.0.0.1.0 build 53
Avaya IP Office Manager 10.0.0.1.0 build 53
Avaya Voicemail Pro for IP Office 10.0.0.1.0 build 53
Avaya Session Border Controller for 7.1.0.1-07-12090
Enterprise (running on Portwell CAD-0208 sbce-7.1.0.1-07-12090-patch-trunkauth
platform) sbee-7.1.0.1-07-12090-hotfix-12062016
Avaya 11x0 IP Telephone (SIP) SIP11x0e04.04.23.00
Avaya 9621G IP Telephone (H.323) 6.6.2.29.050316
Avaya Communicator for Windows 2.1.3
Avaya Communicator for Web (WebRTC) 1.0.16.2115
Avaya Digital Telephone (9508) 0.45
Avaya Symphony 2000 Analog Telephone N/A

Liechtenstein SIP Trunking Service Components

Component Release
Oracle SBC Net-Net 3820 6.40
Teles C5 Proxy 5.0.8.48-2

Note: The test results documented in this Application Notes apply to standalone IP Office V2
deployments as well as all configurations of I[P Office Server Edition.
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5. Configure Avaya IP Office

This section describes the Avaya IP Office configuration to support connectivity to Liechtenstein
SIP Trunking service through Avaya SBCE. Avaya IP Office is configured through the Avaya IP
Office Manager PC application. From a PC running the Avaya IP Office Manager application, select
Start 2> Programs - IP Office > Manager to launch the application. Navigate to File > Open
Configuration, select the proper Avaya IP Office system from the pop-up window, and log in with
the appropriate credentials. A management window will appear similar to the one shown in the next
section. The appearance of the IP Office Manager can also be customized using the View menu. In
some screens presented in this section, the View menu was configured to show the Navigation pane
on the left side, the Group pane in the center, and the Details pane on the right side. Some of these
panes will be referenced in Avaya IP Office configuration. Proper licensing as well as standard
feature configurations that are not directly related to the interface with the service provider (such as
LAN interface to the enterprise site) is assumed to be already in place.

5.1. LAN Settings

In the sample configuration, the SEQT VM was used as the system name and the WAN port was
used to connect the Avaya IP Office to the public network. The LAN2 settings correspond to the
WAN port on the Avaya IP Office.

To access the LAN settings, first navigate to System (1) 2 SEQT VM in the Navigation and then
navigate to the LAN2 > LAN Settings tab in the Details pane.

e Set the IP Address field to the IP address assigned to the IP Office WAN port.

e Set the IP Mask field to the mask used on the public network.

e All other parameters should be set according to customer requirements.

e Click OK.

Configuration ‘E? SEQT VM* = x| v ==

2R BOOTP (8)

VolP Security Contact Center
H-{#% Operator (3)

2489 Solution System LAN1 LANZ DNS  Voicemail Telephony Directory Services System Events SMTP  SMDR  VolP
+: User(30) LAN Settings  yolP Metwork Topolo
+ﬂ Group(1) i’
+-@% Short Code(45) IP Address 10 10 97 61
- Directory(0)
£ Time Profile(0) IP Mask 255 . 255 . 25F . 240

----- | Account Code(D)
+-§5 User Rights(9)
Er} Location(0)
—-=p SEQT VM

-5 System (1) DHCP Mode
1——;' L;HESESTVM () Server () Client (®) Disabled Advanced

+
#-<2¢ Control Unit (8)
+
+

-

Murnber Of DHCP IP Addresses 200

H-4 Extension (6)
0@ User (7) Help
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Select the VoIP tab as shown in the following screen.

e Ensure H323 Gatekeeper Enable box is unchecked.

e The SIP Trunks Enable box must be checked to enable the configuration of SIP trunks to
Liechtenstein.

e The SIP Registrar Enable box is checked to allow IP Office SIP endpoints usage.

e The Layer 4 Protocol, check the UDP, TCP and TLS boxes. Then set UDP and TCP Ports
to 5060, and TLS port to 5061.

e Enable RTCP Monitoring on Port 5005 and Keepalives should be set as shown in capture

below.
e All other parameters should be set according to customer requirements.
e C(Click OK.
Configuration b= SEQT VM* &5 - el Il
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[+ Control Unit (8)
[+ Extension (8]
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- Directory (0)
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LAN Settings VolP MNetwork Topology
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[] Auto-create Extension Auto-create User [] H.323 Remote Extension Enable

Disabled 1720 =

H.323 Signaling over TLS
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SIP Registrar Enable

[ Auto-create Extension/User [] SIP Rerote Extension Enable

SIP Domain Name | ‘

SIP Registrar FQDN | |

uDP
Tce
LS

UDP Port 3060 = 5060 =
Layer 4 Protocol TCP Port  |3060 = 5060 =
TLSPort  |3061 > 5061 =

Challenge Expiraticn Time (sec) 10 -

RTP
Port Number Range

Minimurn 40750 - Maximum 50730 >

Port Number Range (MAT)

Minimum 40730 - Maximum 30730 =

Enable RTCP Monitoring on Port 5003

RTCP collector IP address for phones 0 0 0 0
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RTP-RTCP

Scope ~ | Periodic timeout
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OK Cancel Help
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On the Network Topology tab in the Details pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Set Binding Refresh Time (seconds) to 60. This value is used as one input to determine the
frequency at which IP Office will send SIP OPTIONS messages to the service provider.

e Set Public IP Address to the IP address of IP Office WAN port. Public Port is set to 5060
for UDP and TCP, and 5061 for TLS.

e All other parameters should be set according to customer requirements.

e C(Click OK.
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ik : Public Port
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In the compliance test, the LANI interface was used to connect IP Office to the enterprise site IP
network. The LAN1 interface configuration is not directly relevant to the interface with
Liechtenstein SIP Trunking service, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings

Navigate to the Telephony - Telephony Tab in the Details pane.
e Choose the Companding Law typical for the enterprise location. For North America, A-
LAW is used as member is in Europe.
e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call
transfer to the PSTN via the service provider across the SIP trunk.

e Check the Drop External Only Impromptu Conference box to allow the host of 3 way
conference leaving the active call and forcing all the parties off the conference as member

requested.
e Other parameters are left at default.
e C(Click OK.
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5.3. VoIP Security Settings

When enabling SRTP on the system, the recommended setting for Media is Preferred. In this
scenario, IP Office uses SRTP if supported by the other end, and otherwise uses RTP. If the
Enforced setting is used, and SRTP is not supported by the other end, the call is not established.

Individual SIP lines and extensions have media security settings that can override system level
settings. This can be used for special cases where the trunk or extension setting must be different
from the system settings.

In the compliance testing, Preferred is set at system, trunk and extension level to allow the system to
fall back to none-secure media in case there is issue with SRTP. This would help to avoid blackout
situation within the enterprise network. In some specific deployments, if supported, Enforce is set at
trunk level to ensure the secured communication over the public internet using both signaling (TLS)
and media (SRTP). Navigate to System = VolP Security tab and configure as follows:

o Select Preferred for Media Security. The system attempts to use secure media first and if

unsuccessful, falls back to non-secure media within the IP Office system.

e Check RTCP check-box.

e Other parameters are left as default.

e C(Click OK.

Configuration 7 SEQTVM* e i

:’! E]OOTE (9()3J 2 System LANT LANZ  DNS Voicemnail Telephony Directory Services  System Events  SMTP SMDR - VoIP
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5-#=9 Solution VolP Security  Contact Center
w-§  User (30) ~
+,a Group(1) Media Preferred g [ Strict SIPS
8% Short Code(45)
a8 Directory(0)
----- 71 Time Profile(0)
""" ? SCCUE_”thCUSE(D] Media Security Options
-
,EI L;:;tilogn(g( ) Encryptions RTP
-5 SEQT VM RTCP
E ‘“LS {r%t:gggarm Authentication RTP
@17 Line (5) RTCP
+ -2 Control Unit (8) Replay Protection
o o) SRTP Window Size |64
+! = Uszer (7)
o ﬂ Group (0) Crypto Suites
+ @K Short Code (51) SRTP_AES_CM_128 SHA1_ 80
4B Service (0) SRTP_AES_CM_128_SHA1 32
E: e Incoming Call Rou
- Directory (0)
i Time Profile (0)
+-ll IP Route (1)
----- 8 Account Code () oK Cancel Help

5.4. Administer a SIP Line

A SIP line is needed to establish the SIP connection between IP Office and Liechtenstein SIP
Trunking service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the
template.
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Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

IP addresses.

SIP Credentials (if applicable).

SIP URI entries.

Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.4.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.

Alternatively, a SIP Line can be created manually. To do so right-click Line in the Navigation Pane
and select New = SIP Line, then follow the steps outlined in Sections 5.4.2.

5.4.1. Create SIP Line from Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to AF-Liechtenstein-SIPTrunk-IPO10-SBCE71.xml. The file name is
important in locating the proper template file in Step 4.

2. Import the template into I[P Office Manager.
From IP Office Manager, select Tools 2 Import Templates in Manager. This action will
copy the template file into the IP Office template directory. The default template location is
C:\Program Files\Avaya\IP Office\Manager\Templates.

E HAovaya IP Office Manager for Server Edition SECQT Vi [10.0.0.0.0 build 550]
File Edit Wiew Tools Help
E E Extension Renumber...
SEQT VM LS R o -
= Server Edition Service User Management = =
Configurati SIP Line - Line 19
Busy on Held Validation
+l{ BOOQTP (8) redentials SIP Adwanced Engineering
-7 Operator (3) MSM Configuration
=-*=%# Solution Print Button Labels -
- User(30)
+_;a Group(1) Import Templates in Manager | |
+-@% Short Code License Migration
----- am Directorny(0) T |

In the resulting pop-up window that appears (not shown), select the directory where the
template file was copied in Step 1. After the import is complete, a final import status pop-up
window will appear (not shown) stating success or failure. Next click OK (not shown) to
continue. If preferred, this step may be skipped if the template file is copied directly to the IP
Office template directory.
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3. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New - New from Template > Open from file.

Configuration | = SIP Line - Line
a BOOTP (&) SIP Line Transport SIP URI VolP SIP Credentials SIP Adwvanced Engineering
O perator (3}
=-==¢ Solution Line Mumber =

B User(20)

Group(1]) ITSP Domain Mame |
Short Code (45)
Drirectory (00 Local Domain MName |
Z Time Profile ()
SAccount Code(0]) URI Type il
% User Right=(3) Location Clowud

Location{D]}
7 SECET W
P Swyst

Pl 3

Cut Crl+ 2

fx C

Copy Crl+C

Paste Cerl+W

Drelete Ctrl+Drel

X

Walidate

———

o | Mew from Template »

O pen from file “

Export as Template
= Directory (07 ‘l CrEST T EToTT

4. On Open pop-up windows, Navigate to Manager = Templates, make sure Template File
(.xml) is the file type selected. Then select the file “AF-Liechtenstein-SIPTrunk-IPO10-
SBCE71.xml”. Click Open and OK (not shown).

%" Open =
e R « Awvaya » IP Office » Manager ¥ manager_files » template w | O Search template gl
de-DE
Organize Mew folder H=z - 1n | e
en-Us
A Ouick access o MName - MK Type Size
I Desktop il h.
IPSET-UMNISTIM-CTM
* Downloads
¢ it-1T
el Documents LVMGreeting

&= Pictures manager_files

How to commar MemoryCards
IPO10OSBCET nl-ML
IPO10SBCET Phonelmages
template PEEE
ru-RU
[ Desktop Templates
@ OneDrive WV3_2 999
a Cuang zh-Hans
@ This PC
“
File name: v| Template Files (*.xml) ~

CEHCEI

5. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Section 5.4.2.
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5.4.2. Create SIP Line Manually

To create a SIP line, begin by navigating to Line in the left Navigation pane and then right click to
select New = SIP Line. On the SIP Line tab in the Details pane, configure the parameters as
shown below:
e Set ITSP Domain Name to the ITSP domain so that IP Office uses this domain as the host
portion of SIP URI in SIP headers such as the From header.
e Check the In Service box.
e Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS
method to periodically check the SIP Line.
¢ Incoming Supervised REFER is set to Auto to allow IP Office to support call transfer using
re-INVITE and REFER methods.
¢ Outgoing Supervised REFER is set to Auto to allow IP Office to support call transfer using
re-INVITE and REFER methods.
e Other parameters are set as default values.

e Click OK.
Configuration | = SIP Line - Line 2 gt -8 X v <>
+a BOOTP (10) SIP Line Transport SIP URI VolP  SIP Credentials SIP Advanced Engineering
# Operator (3) p
EUIUtm” Line Number 2 - In Service
M@ User(31)
-4 Group() TSP Domain Name [¢100000d.convoip.i | checkoos
[H-8X Short Code(43)
a8 Directory(0) Local Domain Name | |
('“ Time Profile(0) Session Timers
- Account Code(0) URIType sIP i
-3 User Rights(0) i on Cloud o] Refresh Method Auto v
Timer (sec) On Demand =
= SEQT VM _
=17 Line (6) rEtog | |
..... 1
..... : 2 Mational Prefix | |
""" : . i International Prefix | |
----- : 5 Country Code | | Redirect and Transfer
----- . 19 : 2
< Control Unit (£| Mame Priority System Default v Incoming Supervised REFER Auto ~
f Sd:en(ssw)on M Description | | Outgoing Supervised REFER Auto A
= ser
..... : MNolser Send 302 Moved Temporarily O
----- &~ 2350 H322 ;g
_____ &' 2551 1323 Outgoing Blind REFER O v
----- §- 2552 H323-| ¢ >
----- & 2555 51PS.
----- & 2556 5IPS-: Hel
----- fr 2957 5IP Lo
QT; Reviewed: Solution & Interoperability Test Lab Application Notes 14 of 56

DS mm/dd/yyyy ©2016 Avaya Inc. All Rights Reserved. TLSIPO10SBCE71



Select the Transport tab and enter the following information.

e The ITSP Proxy Address is set to the internal interface of Avaya SBCE.

e Layer 4 Protocol is set to 7LS.

e Send Port is set to the port number of [P Office, 5061.

e Use Network Topology Info parameter is set to LAN 2. This associates the SIP Line with
the parameters in the System - LAN2 - Network Topology tab.
Other parameters retain default values in the screen below.

e Click OK.
Configuration | 7 SIP Line - Line 2* g -9 K| v ]< >
=R BOOTP (10) SIP Line Transport SIP URI VolP  SIP Credentials SIP Advanced Engineering
+-4% Operator (3) S
=% Solution ITSP Proxy Address [10.10.97.176 |
+-§  User(31)
+ﬂ Group(1) : A
-8 Shart Code(45) MNetwork Configuration
-2 Directory(0) Layer 4 Protocol TLS ~ Send Port 3061 =
£ Time Profile(0)
& Account Code(0) Use Metwork Topology Info | LAN 2 ~ 5061 =
+I-§5 User Rights(9)
5B Location(0) Explicit DNS Server(s) 0 0 0 o |[ o 0 0 0

=143y SEQT VM
Calls Route via Registrar

Separate Registrar |

0OK Cancel Help

A SIP URI entry Channel 1 is created to match incoming numbers that IP Office will accept on this
line. Select the SIP URI tab, click Add button and then New Channel area will appear at the bottom
of the pane. To edit an existing entry, click an entry in the list at the top, and click the Edit... button.
In the example screen below, a previously configured entry is edited. For the compliance test, a
single SIP URI entry was created that matched any DID number assigned to an IP Office user. The
entry was created with the parameters shown below:

e Set Local URI, Contact and Display Name to Use Internal Data. This setting allows calls
on this line which SIP URI matches the number set in the SIP tab of any User as shown in
Section 5.6.

Set Identity to None and Header to P Asserted ID for Identity.

Set Sent Caller ID to Diversion Header for Forward and Twinning.

Set Diversion Header to None.

Associate this line with an incoming line group in the Incoming Group field. This line group

number will be used in defining incoming call routes for this line. Similarly, associate the

line to an outgoing line group using the Outgoing Group field. For the compliance test, a

new incoming and outgoing group 2 was defined that only contains this line (line 4).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

e Other parameters retain default values and or set according customer requirements.

¢ Click OK.
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SIP Entry Channel 1 is shown below.

Configuration |

SIP Line - Line 2

e M X[ v <

>

=& BOOTP (10)

% Operator (3)

-5 Solution

0§ User(31)

-8 Group(1)

H- 8% Short Code(45)
-8 Directorny(0)

£ Time Profile(0)
-l Account Code(0)
-3 User Rights(9)
- Location(0)
EI-429 SEQT VM

! Systemn (1)
% SEQT VM
-4 Line (6)

..... 1

[

i

e

£

(E3}

[#-<=» Control Unit (8)
(- Extension (7)
= User (8)
; NoUser
----- &~ 2550 H323-25¢
----- & 2551 H323-25¢
----- § 2552 H323-25¢
----- §= 2555 5IPS-255¢
----- § 2556 5IP5-255¢
----- & 2557 5IPS-255,
----- §r 2558 51PS-255¢
----- ﬂ Group (0)
#-8% Short Code (51)
----- B Service (0)
E]---@ Inceming Call Rou
----- @ Directory (0)
£ Time Profile (0)
&-Jill IP Route (1)
----- | Account Code (0)
----- % License (31)

1 &

SIP Line Transport SIF URI yolp

SIP Credentials SIP Advanced Engineering

Edit URI

Local URI
Contact
Display Mame
|dentity
Identity

Header

Ferwarding And

Originator
Murmber

Send Caller ID

Diversicn Header
Registration

Inceming Group

URl  Groups Local URI

<|Internal>

Contact

<Internal>

<Internal>

Display Mame Identity Header Originator Number Send Caller D Diy Add...
PAI

|Use Internal Data

|U5e Internal Data

|U5e Internal Data

|N0ne

P Ascerted ID

Twinning

Diversicn Header

|N0ne w
0: <Mene> ~

Diversion

Remaove

Edit...

oK

Cancel

Help

Select the VoIP tab to set the Voice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:
e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified.
o Selecting G.711 ALAW and G.729 codec supported by the Liechtenstein SIP Trunking
service, in the Session Description Protocol (SDP) offer.
e Set Fax Transport Support to G.711 from the pull-down.
e Set the DTMF Support field to RFC2833/RFC4733 from the pull-down menu. This directs
IP Office to send DTMEF tones using RTP events messages as defined in RFC2833.
e Check the Re-invite Supported box.
e Check the PRACK/100rel Supported box.
e Media Security is set to Same as System (Preferred) and check the Same As System

checkbox.

e Default values may be used for all other parameters.

e Click OK.
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Configuration i= SIP Line - Line 2 ait ol X <>

BOOTP (10) SIP Line Transport SIP URI VoIP  SIP Credentials SIP Advanced Engineering
Operator (3)
' Solution [ Lecal Held Music A
E-§  User(31)
(5§ Group(1)
(8% Short Code(43) Codec Selection Custom s [ Codec Lockdown

----- = Directory(0)
..... £7) Time Profile(0) i Selected [ Allow Direct Media Path

A G.711 ULAW 64K G.711 ALAW 64K
7; ﬁzﬁ_f :ir;thf;;;([)] G.722 64K Gt 6.729(a) 8K CS-ACELP Force direct media with phone

----- & Location(0) PRACK/100rel Supported
=43¢ SEQT VM
I3 System (1)

Re-invite Supported

-2 Cantral Unit ( Fax Transport Support | G.711 ~

-4 Extension (7)
1§ User (8)
----- S Molser

-

DTMF Support RFC2833/RFC4733 ~

Media Security Same as Systemn (Preferred) S

----- &~ 2551 H323 Advanced Media Security Options Same As Systemn

RTP
----- &~ 2558 5IPS- TCP

-@% Short Code (5 RTP

----- B Service (0)
(-4 Incoming Call

RTCP

..... % License (31)
1§53 User Rights (9 e

-

I ARS (1) SRTP AES CM 128 SHAT 32
_____ P SRTP_AES_CM_128_SHA1_32

----- 28 Authorization | € ?
[#-%29 [PO 5P EXP

Help

5.5. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, select Short
Code in the left Navigation pane, then right-click in the Group Pane and select New. On the Short
Code tab in the Details pane, configure the parameters for the new short code to be created. The
screen below shows the details of the previously administered “6N;” short code used in the test
configuration.
¢ In the Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 6NV, this short code will be invoked when the user dials 6 followed by any
number.
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to the value shown in the capture bellow. This field is used to
construct the Request URI and To headers in the outgoing SIP INVITE message. The value
N represents the number dialed by the user. The host part following the “@” is the domain of
the service provider network.
e Set the Line Group Id to the outgoing line group number defined on the SIP URI tab on the
SIP Line in Section 5.4. This short code will use this line group when placing the outbound
call.
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e Others parameters are at default values.
e Click OK.

Configuration | Short Code = 6N;: Dial ef - X|vl<|>
BOOTP (10) Code Telephone Number |l Short Code
Operator (3) x*51
y ;Dluljlonen 52 Code |5N,‘ |
ser )
..... ﬁ Group(1) P53 NE N Feature Dial s
----- 8% Short Code(45) 8755 . o
..... 2= Directory(0) PRASTNE N Telephone Number |N @t100000d.convoip.li |
e ;lme Prmgleé[)] o eETNE N Line Group 1D |2 v|
ccou.nt ode(0) %70 NE N
~f3 User Rights(9) BRTINE N Locale -
o0 "edit_messages” Force Account Code O
Bon; LI Z.Ermeaipdl Force Authorization Code []
TN
- Contrql Unit (8) XN
A& Extension (7) XN N
§ User(y)
3% Group (0) BXFNEOD 00 ] Help
8% Short Code (51) £ 2

For incoming calls from mobility extension to FNE (Feature Name/Number Extension) hosted by IP
Office to provide dial tone functionality, Short Code FNE0O was created. The FNEOO was

configured with the following parameters.

e In the Code ficld, enter the FNE feature code as FNEOO for dial tone.

e Set the Feature ficld to FNE Service.
e Set the Telephone Number field to 00.
e Set the Line Group ID field to 0.
e Retain default values for other fields.
e (lick OK.
Configuration | Short Code = FNEO0O: FNE Service ek - X|lw|<]>
BOOTP (10) Code Telephone Number |l Short Code
Operator (3) x*51
7 Solution % Code FMEQD
..... a User(31) ::*52* " | |
..... @ Group(1) 53*N# N Feature FME Service ~
----- 8% Short Code(45) %755
..... @ Directory(0) X5 NE N Telephone Mumber |DD |
----- £ Time Profile(D) BXEETNE N g »
3 Account Code(l) BNATONE N Line Group ID |D |
----- 1 UserRights(9) — T
""" & Location(0) BTN N ) i
SEQT VM %95, "edit_messages” Force Account Code O
System (1) BXEN; N"@t100000d. convoip.li” Force Authorization Code [
Line (8] . TN N"@avayalab.com”
= Control Unit (g) oMEN;  N"@t100000d.convoip.li”
4 Extension (7) oxoN N
§ User(®) o5
% Group (0) FNEDD 0D v Fielp
-@% Short Code (51) 2 2
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5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.4. To configure these settings, first select User in the left Navigation pane, then
select the name of the user to be modified in the center Group pane. In the example below, the name
of the user is “H323-2550”. Select the SIP tab in the Details pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4). The
example below shows the settings for user H323-2550.
e The SIP Name and Contact are set to one of the DID numbers assigned to the enterprise
from service provider.
e The SIP Display Name (Alias) parameter can optionally be configured with a descriptive
name.
e Ifall calls involving this user and a SIP Line should be considered private, then the
Anonymous box may be checked to withhold the user’s information from the network.
e Click OK.

Configuration | User = H323-2550: 2550 g - X|v|<]|>
R BOOTP (10) MName Extension

“ Operator (3) frH323-2550 2350
<7 Solution

User Voicemnail DND Short Codes  Source Numbers  Telephony Forwarding Dial In - Voice Recording

Personal Directory  Web Self-Administration

§ User3n) I HBE255 25 Button P ing MenuP ing Mobility Group Membership A ts SIP

""" utton Frogramiming ENu Frogramming ool roup EMDErsnip nnouncements

..... 2% Group(1) f§rH323-2552 2552 R
----- 8% Short Code(45) fmNoUser SIP Name [004232372780 |

----- = Directory(0) grsips-2555 2555 _ _

{7 Time Profile(0) frsips-2556 2556 SIP Display Narne (Alias) |H323-2550 |

""" e e frsips-2557 2557 Contact [004232372780 |

----- §5 User Rights(g)
&5 Location(D)

§sips-2558 2338

=) System (1) [ Anenymous
4 Line (8)
= Control Unit (8) &

28 Group (0) Help
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One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User H323-2550.
e The Mobility Features and Mobile Twinning boxes are checked.
e The Twinned Mobile Number field is configured with the number to dial to reach the
twinned mobile telephone, in this case 60016139675205.
e Check Mobile Call Control check-box.
e Other options can be set according to customer requirements.

e Click OK.
Configuration | User 7 H323-2550: 2550* gk - X[ v]<]|>
¢~ & BOOTP (10) feme i User Voicemail DND Short Codes  Source Mumbers  Telephony Forwarding  Dial In - Voice Recording

Operator (3) $-H323-2550 2550 ————

Solution &"H323-2551 e Web Self-Administration -

£ User(31) frH323-2552 2552 Button Programming  Menu Programming  Mebility  Group Membership  Announcements  SIP Personal Directory
----- W% Group(1) ) =
..... X Short Code(45) SmNoUser [ Internal Twinning
----- @ Directory(0) §rsips-2555 2555 N

! Time Profile(0) §-51P5-2556 2556

i Account Code(0) §rsips-2557 2557 1

‘&5 User Rights(9)
..... ,El Location(0) aHSIPS-ZSSS 2338 Twin Bridge Appearances

E-4

' SEQT VM

Twin Coverage Appearances
-2 System (1) - SRR

Twin Line Appearances

----- <2 Control Unit (8)

..... & Extension (7) Maobility Features

----- % gser (810 Mahile Twinning

----- ox srzztltpc(oLe(sn Z":'c'l‘:;ig”';::'::‘c‘:g‘z:;e] [60016139675205 |
----- B Service (0)

..... ) Incoming Call Rout Twinning Time Profile <None> 5.

Directory (0)

3 Time Profile (0 Mobile Dial Delay (sec) |2 |
----- Bl P Route (1) £ -
0
_____ &m Account Code (0) Mobile Answer Guard (sec) S
""" % License (31) [ Hunt group calls eligible for mobile twinning
----- £ UserRights (9)
..... "¢ ARS (1) [ Forwarded calls eligible for mobile twinning
""" '?‘-? Location (0) [ Twin When Logged Out
----- aﬂ Authorization Code
&% PO SP EXP one-X Mobile Client

Meobile Call Control
[] Mebile Callback

< >

QK LCancel Help

5.7. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, select Incoming Call Route in the left Navigation pane, then right-click in
the center Group pane and select New. On the Standard tab of the Details pane, enter the
parameters as shown below:

e Set the Bearer Capacity to Any Voice.
e Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.4.
e Set the Incoming Number to the incoming number on which this route should match.
e Default values can be used for all other fields.
e Click OK.
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An Incoming Call Route is shown below.

Configuration | Incoming Call Route = 2004232372780 [ B X| v <>
BOOTP (10 Line Group 1D Incoming Number Standard  Vpice Recording  Destinations
Operator (3) d: 004232372786 =
: ;”'“J'””G 5 ®: 004232372781
..... ser = E
..... ﬁ Group(!) @2 004232372780 Bearer Capability Any Voice ~
..... 8% Short Code(d5) @4 004232372785 Line Group ID 2 ~]
@ Directory(0) Q4 004232372783
% nﬂ\ Time Profile(0) @19 6132600000 Incoming Mumber |DD42323?2?SD |
-l Account Code(0)
..... \ ; @1 Bl3c0l 7] Incoming Sub Address | |
§3 User Rights() @19 §132601021
""" & Location(0) 2
=2 SEQT VM Incoming CLI | |
= System (1) iotaie =
..... T'(I Line (6)
----- <= Contrel Unit (8) Priority 1-Low w
----- & Extension (7)
----- ﬁ User (8) Tag | |
..... .ﬂ Group (0)
..... X% Short Code (51) Hold Music Source System Source ~
----- @ Service (0) ) )
_____  Incoming Call Route (8) Ring Tone Override |N0ne v| v
----- #% Directory (0)
{7 Time Profile (0) Help
----- IP Route (11 < > =

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. In this example, incoming calls to 004232372780 on line 2 are routed to extension

2550. Click OK.

Configuration

Incoming Call Route

—

2004232372780

g -8 X[ vl<]>

Line Group ID Incoming Mumber

Standard Voice Recording Destinations

©: s TimeProfile Destination Fallback Extension
@: 004232372781
®: T b |Default Value 2550 H323-2550 v
@4 004232372785
s @4 004232372783
""" short Code (51) @0 £132600900
33333% ISnE::I:neirf;)Call Route @ | @19 JIESL
..... s Directory (0) @19 6132601021
----- £7 Time Profile (0) a 5 23
5.8. Save Configuration
Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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5.9. Avaya IP Office TLS Certificate Management

This section is to provide a procedure how to download the IP Office certificate which is being
installed on Avaya SBCE for the communication between Avaya system’s components using TLS
connectivity.

To download the IP Office certificate, launch a web browser and log in Avaya IP Office Web
Management as shown below.

I Avaya IP Office Web Man: X

« C' | @ https://10.10.97.61:7070/

'ebManagement/WebManagement.htm

<4
i
I

Avaya IP Office Web Manager

User Mame Administrator
Password  sesssssssssses
Select Language English ~

Offine Mode @

& 2016 Avaya Inc. All Rights Reserved.

On the Solution page, click on drop-down menu on the right and select Platform View as shown.

AVAYA
Solution = Call Management = System Settings  Security Manager  Applications
Solution
LUT ECTS
View All (2) Actions - Configure ~
@ SEQTVM 135.10.97.61 = ~
& = Dashboard
Online (2) @ IPO SP EXP 135.10.97.229 G v
Offline (0) Platform View
Backup
. Restore
Servers (1)
Expansions (1) On-boarding
Application Servers (0) FaunduSSa
Service Commands
Initial Configuration
Download Configuration
View Upgrade Report
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On the Platform page, click on Settings and scroll down to Certificates section. At CA Certificate

section, click on Download (PEM-encoded) button to obtain the IP Office CA certificate.

AVAYA
@ Solution = Call Management  System Settings = Security Manager  Applications ‘ ?
Platform - | 10.10.97.61 | &
Settings
I System
Certificates CA Certificate -
Create new '® Renew existing Import Export
Fegenerate Download (PEM-encoded) Download (DER-encoded)

Identity Certificates

#| Renew automatically

Warning: The certificate will be automatically regenerated and replaced for all applications, when a change that causes

itto expire (such as network or LAN change) takes place. This will cause all applications to restart, and you will be

redirected to the login page.

Create certificate for a diffierent machine

Subject Name: 000C29EBBESE

Subject Alternative Name(s): DNS:000C29E8BESE, IP:10.10.97 61, IP:192.168.43.1

Duration (days): 2555

Fublic Key Algorithm: RSA-2048 r

Secure Hash Algorithm: SHA-256 v

Regenerate and Apply Download (PEM-encoded) Download (DER-encoded) u
4
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6. Configure the Avaya Session Border Controller for
Enterprise

This section covers the configuration of the Avaya SBCE. It is assumed that the software has already
been installed. For additional information on these configuration tasks, see Section 10.

The compliance testing comprised the configuration for two major components, Trunk Server for the
service provider and Call Server for the enterprise. Each component consists of a set of Global
Profiles, Domain Policies and Device Specific Settings. The configuration is defined in the Avaya
SBCE web user interface as described in the following sections.

Trunk Server configuration elements for the service provider - Liechtenstein:
e Global Profiles:
o URI Groups
Routing
Topology Hiding
Server Interworking
Signaling Manipulation
o Server Configuration
¢ Domain Policies:
o Application Rules
o Media Rules
o Signaling Rules
o Endpoint Policy Group
o Session Policy
e Device Specific Settings:
o Network Management
Media Interface
Signaling Interface
End Point Flows = Server Flows
Session Flows

(@)
O
(@)
@)

@)
(@)
@)
(@)

Call Server configuration elements for the enterprise - IP Office:
e Global Profiles:
o URI Groups
o Routing
o Topology Hiding
o Server Interworking
o Server Configuration
¢ Domain Policies:
o Application Rules
o Media Rules
o Signaling Rules
o Endpoint Policy Group
o Session Policy
e Device Specific Settings:
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Network Management

Media Interface

Signaling Interface

End Point Flows = Server Flows
Session Flows

O O O O O

The naming convention in this entire section is using as follow:
e SP is stand for Service Provider, which is Liechtenstein in this case.
e EN is stand for Enterprise Network, which refers to Avaya IP Office.

6.1. Log into the Avaya Session Border Controller for Enterprise

Use a Web browser to access the Avaya SBCE Web interface, enter https://<ip-addr>/sbc in the
address field of the web browser, where <ip-addr> is the management IP address.

Enter the appropriate credentials then click Log In.

o v o o Log In
Username: ucsec

Password: (ITITITTITITTTITIT]
Log In
Session Border Controller WELCOME TO AVAYA SBC
for Enterprlse Unauthorized access to this machine is prehibited. This system is for the

use authorized users only. Usage of this system may be monitored and
recorded by system personnel.

Anyone uzing this system expressly consents to such monitoring and is
advised that if such monitoring reveals possible evidence of criminal
activity, system perzonnel may provide the evidence from such
monitoring to law enforcement officials.

@ 2011 - 2018 Avaya Inc. All rights reserved.
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The Dashboard main page will appear as shown below.

Dashboard

Administration

Dashboard

Backup/Restore
System Management
> Global Parameters

> Global Profiles Infarmation

> PPM Services System Time
> Domain Policies

> TLS Management Version

> Device Specific Settings Build Date

License State
Aggregate Licensing Overages

Peak Licensing Overage Count
Last Logged in at

Failed Login Attempts

Alarms (past 24 hours)

MNone found.

Session Border Controller for Enterprise

AVAYA

This system contains one or more Avaya demo certificates. These certificates have been

compromised and should not be used for any production traffic.

Installed Devices

12:57:07
PM CST

Refresh EMS

mSBCE
7.1.0.1-07-12090

Sun Dec 4 19:22:22
EST 2016

@ 0K
0
0

12/11/2016 10:21:54
CST

0

Incidents (past 24 hours)

mSBCE : Heartbeat Successful, Semver is UP

6.2. TLS Management

Transport Layer Security (TLS) is a standard protocol that is used extensively to provide a secure
channel by encrypting communications over IP networks. It enables clients to authenticate servers
or, optionally, servers to authenticate clients. The Avaya SBCE utilizes TLS primarily to facilitate

secure communications with remote users.

Avaya SBCE is preinstalled with several certificates and profiles that can be used to quickly set up
secure communication using TLS, which are listed in the Pre-installed Avaya Profiles and
Certificates section. IP Office, Avaya SBCE and the 96x1 IP Desk-phones are shipped with a default
identity certificate to enable out-of-box support for TLS sessions. Do not use this default certificate
in a production/customer environment since this certificate is common across all instances of [P
Office, Avaya SBCE and the 96x1 IP Desk-phones. Avaya SBCE supports the configuration of
third-party certificates and TLS settings. For optimum security, Avaya recommends using third-

party CA certificates for enhanced security.

Testing was done with default identity certificate. The procedure to obtain and install 3™ party CA
certificates is outside the scope of these application notes.

In this compliance testing, TLS transport is used for the communication between IP Office and
Avaya SBCE. The following procedures show how to create the client and server profiles.
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6.2.1. Certificates

You can use the certificate management functionality that is built into the Avaya SBCE to control all

certificates used in TLS handshakes. You can access the Certificates screen from TLS Management
- Certificates.

Ensure the preinstalled certificates are presented in the system as shown below.
e AvayaSBCCA.crt is Avaya SBCE Certificate Authority root certificate.
e root-ca.pem is the I[P Office root certificate obtained from Section 5.9.

Session Border Controller for Enterprise AVAYA
Dashboard Certificates
Administration Install Generate CSR

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> PPM Services

> Domain Policies

4 TLS Management
Certificates
Client Profiles
Server Profiles

> Device Specific Settings

Certificates

Installed Certificates

AvayaSBC.crt View Delete

SymantecClass3 pem View Delete

Installed CA Certificates

AvayaSBCCA crt View Delete

root-ca.pem View Delete

Installed Certificate Revocation Lists

No certificate revocation lists have been installed.

Installed Keys

AvayaSBC key Delete
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If the IP Office Certificate Authority certificate (root-ca.pem) is not present, the following procedure
will show how to install it here on Avaya SBCE.

IP Office CA certificate is obtained using procedure provided in Section 5.9. Then on Avaya SBCE,
navigate to TLS Management - Certificates. Click on Install button.
e Select CA Certificate.
e Provide a descriptive Name. In the example below, the Name field was left empty and
default name was used as root-ca.pem.
¢ Browse to the directory where the IP Office CA previously saved and select it.
e Click Upload.

Install Certificate X

O Certificate
Type @ CA Certificate
O Certificate Revocation List
Mame |
Owerwrite Existing O
Allow Wealk Certificate/Key L]
Certificate File root-ca.pem

Upload

6.2.2. Client Profiles

This section describes the procedure to create client profile for Avaya SBCE to communicate with IP
Office via TLS signalling.

To create Client profile, navigate to TLS Management - Client Profiles, click Add.
e Enter descriptive name in Profile Name.
o Select AvayaSBC.crt from pull down menu of Certificate.
e For Peer Verification, select IP Office CA certificate which was installed in the above
section.
e Enter I as Verification Depth.
e Click Finish.
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Capture below illustrates a client profile being created on Avaya SBCE.

Edit Profile X

1 to have been compromised and should not be L

es cipher checking, Cipher Suite validation will
re invalid g as at least one c alid. Make
valid or incorrectly entered Cipher Suite custom values

TLS Profile
Frofile Name |A1.ra1,raSBCCIient—Q |
Certificate |A~.ra:.raSBC.crt v|

Certificate Info

Peer Verification Required
P Certifi Authoriti root-ca.crt
eer Certificate Authonties Cisco_phone_CA.crt
SymantecClass3.pem "

Peer Certificate Revocation Lists

Verification Depth

Renegotiation Parameters

Renegotiation Time ICI seconds

Renegotiation Byte Count |I:|

Handshake Options

Version TLS 1.2 TLS 11 TLS 1.0
Ciphers ® Defaut O FIPS O Custom
Value HIGH:!DH:!ADH:!MD5:!aNULL:leMULL: @ STRENGTH

{What's this?)

Finish
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6.2.3. Server Profiles

This section describes the procedure to create server profile for Avaya SBCE to communicate with
IP Office via TLS signalling.

To create Server profile, navigate to TLS Management - Server Profiles, click Add.
e Enter descriptive name in Profile Name.
o Select AvayaSBC.crt from pull down menu of Certificate.
e Select None from pull down menu of Peer Verification.
e Select Custom for Ciphers in Cipher Suit Options section. And Value is specified in the
capture shown below.
e C(Click Finish.

Edit Profile X
TLS Profile

Profile Mame |A\.ra1,raSE|CSewer |

Certificate |A~.ra:.raSEC.cr't v|

Certificate Info

Peer Verification
AvayaSBCCA.crt -~
I o e e e ¥ EI’ISILjI'l. Universal Root Certification Authority.cer
SMGRCA.pem
Affiliated.crt w
Peer Certificate Revocation Lists
Verification Depth 0

Renegotiation Parameters

Renegotiation Time I:I seconds

Renegotiation Byte Count |IZ|

Handshake Options

Version TLS 1.2 TLS 1.1 TLS 1.0
Ciphers O Default O FIPS @ Custom
VE'UE |.F't|_|_

{What's this>}

Finish
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6.3. Global Profiles

Global Profiles allows for configuration of parameters across all Avaya SBCE appliances.

6.3.1. Uniform Resource Identifier (URI) Groups

URI Group feature allows user to create any number of logical URI groups that are comprised of
individual SIP subscribers located in that particular domain or group. These groups are used by the
various domain policies to determine which actions (Allow, Block, or Apply Policy) should be used
for a given call flow.

oo

For this configuration testing, is used for all incoming and outgoing traffic.

6.3.2. Server Interworking Profile
Interworking Profile features are configured differently for Call Server and Trunk Server.

To create a Server Interworking profile, select Global Profiles = Server Interworking. Click on
the Add button.

In the compliance testing, two Server Interworking profiles were created for SP and EN respectively.
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6.3.2.1 Server Interworking Profile for SP
Profile SP-SI was defined to match the specification of SP. The General, URI Manipulation and

Advanced tabs are configured with the following parameters while the other tabs for Timers,
Privacy and Header Manipulations are kept as default.

General tab:

e Hold Support = NONE. The Avaya SBCE will not modify the hold/ resume signaling from
EN to SP.

e 18X Handling = None. The Avaya SBCE will not handle 18X, it will keep the 18X
messages unchanged from EN to SP.

e Refer Handling = No. The Avaya SBCE will not handle REFER. It will keep the REFER
message unchanged from EN to SP.

e T.38 Support = No. SP does support T.38 fax in the compliance testing.

e Others are left as default values.

The screenshots below illustrate the Server Interworking profile SP-SI, General.

Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: SP-SI
DT Add Rename Clone Delete
Backup/Restore
Inte ki Click here scription.
System Management Sr;a:;r ing lick here to add a description
> Global Parameters 52100 General | | Timers || Privacy | | URI Manipulation | | Header Manipulation || Advanced |
4 (Global Profiles
Server Interworking 0OCS-Edge-S... Hold Support NONE
Media Forking cisco-com 180 Handling Maone
Routing 181 Handling Mone
' . cups
Server Configuration . 182 Handiing Moo
Topology Hiding Sipera-Halo
: i 5 i 183 Handling Mone
Signaling Manipulation OCS-FrontEn...
URI Groups = Refer Handling Mo
SHNMP Traps URI Group MNane
Time of Day Rules MTSAllstream T iz
EN-SI
RO oo Delayed Offer Mo
Reverse Proxy Policy RC
B 3xx Handli M
> PPM Services ” it e
> Domain Policies Hleetls Diversion Header Support Mo
> TLS Management 5P-31 Delayed SDP Handling No
> Device Specific Settings SP4 Re-Invite Handling No
IPO_42 Prack Handling Mo
IPO_14 Allow 18X SDP Nao
T.38 Support Mo
URI Scheme SIP
Via Header Format RFC3261
Edit
QT; Reviewed: Solution & Interoperability Test Lab Application Notes 32 of 56

DS mm/dd/yyyy ©2016 Avaya Inc. All Rights Reserved. TLSIPO10SBCE71



Advanced tab:

e Record Routes = Both Sides. The Avaya SBCE will send Record-Route header to both call
and trunk servers.

e Include End Point IP for Context Lookup = No.

e Extensions = Avaya.

e Has Remote SBC = Yes. This setting allows the Avaya SBCE to always use the SDP
received from EN for the media.

e DTMF Support = None. The Avaya SBCE will send original DTMF method from SP to

EN.

e Others are left as default values.

The screenshots below illustrate the Server Interworking profile SP-SI, Advanced.

Dashboard
Administration
Backup/Restore
System Management

Session Border Controller for Enterprise

Interworking Profiles: SP-SI
Add

Click here

Interworking

Profiles

AVAYA

Rename Clone Delete

to add a description.

* Global Parameters EN-SI General | | Timers | | Privacy | | URI Manipulation || Header Manipulation || Advanced L
4 Global Profiles

Domain DoS (=] Record Routes Both Sides

Server Interwerking Include End Point IP for Context Lookup  No

Media Forking Extensions Avaya

Routing Diversion Manipulation Mo

Server Configuration

o Has Remote SBC Yes

Topology Hiding

Signaling Manipulation Route Response on Via Port MNo

URI Groups Relay INVITE Replace for SIPREC Mo

SNMP Traps

Time of Day Rules —

FGDN Groups DTMF Support None
> PPM Services Edit
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6.3.2.2 Server Interworking Profile for EN

Profile EN-SI was defined to match the specification of EN. The General and Advanced tabs are
configured with the following parameters while the other settings for Timers, Privacy, URI
Manipulation and Header Manipulation are kept as default.

General tab:

e Hold Support = NONE.

e 18X Handling = None. The Avaya SBCE will not handle 18X, it will keep the 18X
messages unchanged from SP to EN.

¢ Refer Handling = No. The Avaya SBCE will not handle REFER, it will keep the REFER
messages unchanged from SP to EN.

e T.38 Support = No. To match with SP profile.

e Others are left as default values.

The screenshots below illustrate the Server Interworking profile EN-SI, General.

Session Border Controller for Enterprise AVAYA

Dashboard Interworking Profiles: EN-SI
Administration

Add Rename Clone Delete
Backup/Restore
Inte ki Click here escription.
System Management Fr?n;elg\ln\;c:;r ing lick here to add a description
> Global Parameters 52100 General || Timers | | Privacy | | URI Manipulation || Header Manipulation || Advanced |
4 Global Profiles
! . General
Domain DoS s
Server Interworking OCS-Edge-5... Hold Support oS
Media Forking cisco-com 180 Handling Naone
Routing 181 Handling Nane
S Canfiguration .
Shis LY _ 182 Handling None
Topology Hiding Sipera-Halo
: - . . 183 Handling MNone
Signaling Manipulation 0OCS-FrontEn...
URI Groups Bs Refer Handling No
SMMP Traps URI Group MNone
Time of Day Rules MTSAllstream e e
EN-SI
FCDCes Delayed Offer Mo
Reverse Proxy Policy RC
; 3xx Handli M
> PPM Services : ithabens .
> Domain Policies ThinkTel Diversion Header Support Nao
> TLS Management SP-sl Delayed SDP Handling No
> Device Specific Settings SP4 Re-Imite Handling Mo
IPO_42 Prack Handling Mo
IPO_14 Allow 18X SDP Mo
T.38 Support Nao
URI Scheme SIP
Via Header Format RFC3261
Edit
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Advanced tab:

e Record Routes = Both Sides. The Avaya SBCE will send Record-Route header to both call
and trunk servers.

e Include End Point IP for Context Lookup = No.

e Extensions = Avaya.

e Has Remote SBC = Yes. This setting allows the Avaya SBCE to always use the SDP
received from EN for the media.

e DTMF Support = None. The Avaya SBCE will send original DTMF method from SP to
EN.

e Others are left as default values.

The screenshots below illustrate the Server Interworking profile EN-SI, Advanced.

Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: EN-SI
pelTiAraon Add Rename Clone Delete
Backup/Restore
Inte ki Click here scription.

System Management Sﬂe:;:or ing lick here to add a description
> Global Parameters EN.SI General || Timers || Privacy | | URI Manipulation | | Header Manipulation | | Advanced L
[ Global Profiles

Domain DoS spg| Record Routes Both Sides

Server Interworking Include End Point IP for Context Lookup  No

Media Forking Extensions Avaya

Routing Diversion Manipulation Mo

Server Configuration

o Has Remote SBC Yes

Topology Hiding

Signaling Manipulation Route Response on Via Port Mo

URI Groups Relay INVITE Replace for SIPREC Mo

SMMP Traps

Time of Day Rules OTMF

FGDN Groups DTMF Support Naone
> PPM Services Edit

6.3.3. Server Configuration

Server Configuration screen contains four tabs: General, Authentication, Heartbeat, and
Advanced. These tabs are used to configure and manage various SIP Call Server specific parameters
such as TCP and UDP port assignments, heartbeat signaling parameters, DoS security statistics and
trusted domains.

To create a Server Configuration entry, select Global Profiles > Server Configuration. Click Add
button.

In the compliance testing, two separate Server Configurations were created, server entry SP-SC for
SP and server entry EN-SC for EN.
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6.3.3.1 Server Configuration for SP

Server Configuration named SP-SC was created for the SP. It will be discussed in detail below.
General and Advanced tabs are provisioned for SP on the SIP trunk for every outbound call from
enterprise to PSTN. The Authentication is disabled (not shown) to allow IP Office to send out
authentication to SP. Heartbeat tab is kept as disabled as default (not shown) to allow the Avaya
SBCE to forward the OPTIONS heartbeat from EN to SP to query the status of the SIP trunk.

General tab: Click Add button and enter following information.

e Enter Profile Name SP-SC and click Next button (not shown).

e Set Server Type for SP as Trunk Server.

e Enter provided IP Address/FQDN of SP. Transport UDP and listening on port 5083.

¢ C(Click Next, Next and Finish (not shown).
Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: SP-SC
CENDSES Soss Add Rename Clone Delete
- Glo;zlr:::”;zs General | | Authentication | | Heartbeat | | Advanced

Server Interworking EN-SC Server Type Trunk Server

zemt? ok it IP Address / FQDN Transport

outing
Server Configuration 192.168.235.246 5083 ubpP
Topology Hiding Edit

Authentication tab: Click Edit button and enter following information.
e Check the Enable Authentication checkbox.
e Enter the User Name provided by service provider.
e Enter the Password and Confirm Password provided by service provider.
[ ]

Click Finish.
Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: SP-SC

Administration
4 (Global Profiles

) Server Profiles General | | Authentication | | Heartbeat | | Advanced
Domain DoS

Add Rename Clone Delete

Server Interworking i Enable Authentication
Media Forkin L
) = Shpit User Name LITLITestAvayaFL01
Routing
Server Configuration Realm
Topology Hiding Edit
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Heartbeat tab: Click Edit button and enter following information.
Check the Enable Heartbeat checkbox.

°

e Select REGISTER from dropdown list for Method.

e Enter 30 seconds for Frequency.

o Enter user-name@itsp-domain provided by service provider for From URI and To URL.

e Click Finish.
Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: SP-SC
feon Add Rename Clone Delete
Backup/Restore

General || Authentication | | Heartbeat | | Advanced
System Management
» Global Parameters EN-SC Enable Heartheat
4 (Global Profiles SP_SC
) Method REGISTER

Domain DoS

Server Interworking Frequency 30 seconds

Media Forking From URI LITLITestAvayaFL01@t100000d.convoip.li

Routing To URI LITLITestAvayaFL01@t100000d.convoip.li

Server Configuration

Topology Hiding B

Advanced tab: Click Edit button and enter following information.
e Interworking Profile drop down list, select SP-SI as defined in Section 6.3.2.
e The other settings are kept as default. Click Finish (not shown).

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: SP-SC
LN Add Rename Clone Delete
Backup/Restore
General | | Authentication || Heartbeat | | Advanced
System Management
* Global Parameters ENSE Enable DoS Protection O
4 Global Profiles SP.SC
Domain DoS Enable Grooming [ ]
Server Interworking Interworking Profile SP-8l
Media Forking Signaling Manipulation Script Mone
Routi
S Securable O
Server Configuration
Topology Hiding Enable FGDN O
Signali : :
ignaling Manipulation ==
1D] Croyine
QT; Reviewed: Solution & Interoperability Test Lab Application Notes 37 of 56

DS mm/dd/yyyy ©2016 Avaya Inc. All Rights Reserved. TLSIPO10SBCE71




6.3.3.2 Server Configuration for EN

Server Configuration named EN-SC created for EN is discussed in detail below. General and
Advanced tabs are provisioned but no configuration is done for Authentication tab. The Heartbeat
tab is kept as disabled as default to allow the Avaya SBCE to forward the OPTIONS heartbeat from
SP to EN to query the status of the SIP trunk.

General tab: Click Add button then specifying the following.
e Server Type for EN as Call Server and click Next button (not shown).
IP Address/FQDN is IP Office WAN port IP address.
Transport, between the Avaya SBCE and IP Office was TLS, and Port 5061.
TLS Client Profile is the profile created in Section 6.2.2.
Click Next, Next and Finish (not shown).

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: EN-SC
G on Add Rename Clone Delete
Backup/Restore
General | | Authentication | | Heartbeat | | Advanced
System Management
> Global Parameters St Server Type Call Server
4 Global Profiles EN-SC

TLS Client Profile AvayaSBCClient-Q

Domain DoS
IP Address / FQDN

Transport

Server Interworking
Media Forking
Routing

10.10.97.61 5061 TLS

Edit

Server Configuration

Advanced tab: Click Edit button then enter the following information.
e Interworking Profile drop down list select EN-ST as defined in Section Fehler!
Verweisquelle konnte nicht gefunden werden..
e The other settings are kept as default.

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: EN-SC
Gl Add Rename Clone Delete
Backup/Restore
General | | Authentication | | Heartbeat | | Advanced
System Management
> SP-SC
Global Parameters Enable DoS Protection O
4 Global Profiles EN-SC
Domain DoS Enable Grooming |
Server Interworking Interworking Profile EN-5I
Media Forking Signaling Manipulation Script None
Rout
i Securable ]
Server Configuration
Topology Hiding Enable FGDN O
Signaling Manipulation =T,
URI Groups
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6.3.4. Routing Profiles

Routing profiles define a specific set of packet routing criteria that are used in conjunction with other
types of domain policies to identify a particular call flow and thereby ascertain which security
features will be applied to those packets. Parameters defined by Routing profiles include packet
transport settings, name server addresses and resolution methods, next hop routing information and
packet transport types.

To create a Routing profile, select Global Profiles = Routing then click on the Add button.

In the compliance testing, routing profile SP-RP was created to be used in conjunction with Server
Flow (see Section 6.5.4) defined for EN. This entry is to route outgoing calls from the enterprise to
SP.

In the opposite direction, Routing profile EN-RP was created to be used in conjunction with Server
Flow (see Section 6.5.4) defined for SP. This entry is to route incoming calls from SP to the EN.

6.3.4.1 Routing Profile for SP

The screenshot below illustrates the routing profile from Avaya SBCE to the SP network, Global
Profiles = Routing: SP-RP. As shown in Figure 1, the SP SIP trunk is connected with
transportation protocol UDP. If there is a match in the “To” or “Request URI” headers with the URI
Group “*” defined in Section Fehler! Verweisquelle konnte nicht gefunden werden., the call will be
routed to the Next Hop Address which is the IP address of SP SIP trunk.

Session Border Controller for Enterprise AVAYA

Dashboard Routing Profiles: SP-RP
Administration

Add Rename Clone Delete

Backup/Restore

Routing Profiles Click here escription.
System Management outing Profile lick here to add a description

» Global Parameters SPRP Routing Profile

4 Global Profiles
Domain DoS
Server Interworking Priority o~ B — v Transport

Update Priority Add

Group Day Balancing Address

Media Forking
Routing : default  Priority 192168238246  UDP  Edit Delste

Server Configuration
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6.3.4.2 Routing Profile for EN

The Routing Profile for SP to EN, EN-RP was defined to route call where the “To” header matches
the URI Group “*” defined in Section Fehler! Verweisquelle konnte nicht gefunden werden. to Next
Hop Address which is the IP address of I[P Office WAN port as a destination. As shown in Figure
1, the SIP trunk between EN and the Avaya SBCE is connected with transportation protocol 7LsS.

Dashboard
Administration
Backup/Restore

Server Interworking

Session Border Controller for Enterprise

Routing Profiles: EN-RP

Add

AVAYA

Delete

Rename Clone

Priority URI Time of

Load

Routing Profiles Click here escription.
System Management outing Profile lick here to add a description
> Global Parameters S Routing Profile
4 Global Profiles To_IPO
) Update Priority Add
Domain DoS SP-RP

Next Hop

Transport

Group Day Address

:

Balancing
Media Forking

Routing

default Priority 10.10.97.61 TLS Edit Delete

6.3.5. Topology Hiding

Topology Hiding is a security feature of the Avaya SBCE which allows changing certain key SIP
message parameters to ‘hide’ or ‘mask’ how the enterprise network may appear to an unauthorized
or malicious user.

To create a Topology Hiding profile, select Global Profiles & Topology Hiding then click on the
Add Profile (not shown).

In the compliance testing, two Topology Hiding profiles were created: SP-TH and EN-TH.

6.3.5.1 Topology Hiding Profile for SP
Topology Hiding profile SP-TH was defined for outgoing calls to SP as shown in capture below.
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The screenshots below illustrate the Topology Hiding profile SP-TH.

Dashboard

Administration

Backup/Restare

System Management

> Global Parameters

4 Global Profiles
Domain DoS
Server Interworking
Media Forking
Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups
SNMP Traps
Time of Day Rules
FGDN Groups
Reverse Proxv Policy

Topology Hiding Profiles: SP-TH

default

EN-TH
SP.TH

Add

Topology Hiding

Session Border Controller for Enterprise

Click here to add a description.

AVAYA

Rename Clone Delete

Header

Via
Referred-By
Request-Line
Refar-To

SDP
Record-Route
To

From

Criteria

IP/Domain
|P/Domain
IP/Domain
IP/Domain
IP/Domain
IP/Domain
IP/Domain

IP/Domain

Replace Action

Auto
Auto
Cverwrite
Auto
Auto
Auto
Owerwrite

Ovenwrite

Edit

Overwrite Value

t100000d._convoip.li

t100000d.convaip.li

t100000d.convaip.li

6.3.5.2 Topology Hiding Profile for EN
Topology Hiding profile EN-TH was defined for incoming calls to IP Office as shown capture

below.

Dashboard
IAdministration
Backup/Restore
System Management
> Global Parameters

Topology Hiding Profiles: EN-TH

Add

Hiding

Topelegy Hiding

Session Border Controller for Enterprise

Click here to add a description.

AVAYA

Rename Clone Delete

default
1 Global Profiles
Domain DoS EN-TH Header Criteria Replace Action Owverwrite Value
Server Interworking Sp-TH Via |IP/Damain Auto —
Media Forking Referred-By IP/Domain Auto —
Routing Refer-To IP/Domain Auto =
e Conixp o Request Line IP/Domain Overwrite £100000d.convaip.l
Topology Hiding
. > . : SDP IP/Domain Auto -
Signaling Manipulation
URI Groups Record-Route IP/Domain Auto —
SNMP Traps To IP/Domain Owerwrite t100000d.convoip.i
Time of Day Rules From IP/Domain Overwrite t100000d.convaip. i
FGDN Groups
Reverse Proxv Palicy Edit
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6.4. Domain Policies

The Domain Policies feature configures various rule sets (policies) to control unified
communications based upon criteria of communication sessions originating from or terminating at
the enterprise. These criteria can be used to trigger policies which, in turn, activate various security
features of the Avaya SBCE security device to aggregate, monitor, control and normalize call flow.
There are default policies available for use, or a custom domain policy can be created.

6.4.1. Signaling Rules

Signaling Rules define the action to be taken (Allow, Block, Block with Response, etc.) for each
type of SIP-specific signaling request and response message. When SIP signaling packets are
received by the Avaya SBCE, they are parsed and “pattern-matched” against the particular signaling
criteria defined by these rules. Packets matching the criteria defined by the Signaling Rules are
tagged for further policy matching.

To clone a signaling rule, navigate to Domain Policies = Signaling Rules, sclect the default rule
then click on the Clone Rule button (not shown).

In the compliance testing, two Signaling Rules were created for the SP and EN.

6.4.1.1 Signaling Rule for SP

Clone the Signaling Rule default with a descriptive name e.g. SP-SR and click on the Finish button
(not shown). Verify that General settings of SP-SR with Inbound and Outbound Request are set
to Allow, and Enable Content-Type Checks is enabled with Action and Multipart-Action are set
to Allow (not shown).

On the Signaling QoS tab, enter the following information.
e Select the correct Quality of Service (QoS).
e The Avaya SBCE can be configured to mark the Differentiated Services Code Point (DSCP)
in the IP packet header with specific values to support Quality of Services policies for
signaling.

The following screen shows the QoS value used for the compliance testing.

Session Border Controller for Enterprise AVAYA

Dashboard Signaling Rules: SP-SR

JAdministration

Add Filter By Device... - [ Rename ” Clone ” Delete ]
Backup/Restore

Signaling Rules Click here scription.
System Management lick here to add a description

> Global Parameters SP-SR al | Requests | | Responses | | Request Headers | | Response Headers | | Signaling Qo5 |
4 Domain Policies uciD '_‘

Application Rules Signafing QoS

Border Rules

Media Rules QoS Type DSCP

Security Rules DSCP EF

Signaling Rules

Edit
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6.4.1.2 Signaling Rule for EN

Clone the Signaling Rule default with a descriptive name e.g. EN-SR for EN and click on the
Finish button (not shown). Verify that General settings of EN-SR with Inbound and Outbound
Request are set to Allow, and Enable Content-Type Checks is enabled with Action and
Multipart-Action are set to Allow (not shown). Similarly the Signaling QoS rules are set as shown
in capture below.

Similarly the Signaling QoS rules are set as shown in capture below.

Session Border Controller for Enterprise AVAYA
Dashboard Signaling Rules: EN-SR
e Add Filter By Device... M [ Rename ” Clone H Delete ]
Packup/Restore — ; -
Systern Management Signaling Rules Click here to add a description.
" Global Parameters EN-SR meTﬂ| Request || Resp || Request Head || Response Headers || Signaling QoS |
. Domain Policies SP-SR ucio

Application Rules Signaling QoS

Border Rules

Media Rules il Lty

Security Rules DsCP EF

Signaling Rul

Ignaling ~ules m
QT; Reviewed: Solution & Interoperability Test Lab Application Notes 43 of 56

DS mm/dd/yyyy ©2016 Avaya Inc. All Rights Reserved. TLSIPO10SBCE71



6.4.2. Application Rules

Application Rules define which type of SIP based Unified Communications (UC) applications the
Avaya SBCE security device will protect: voice, video, and/or Instant Messaging (IM). In addition,
user can determine the maximum number of concurrent voice and video sessions the network will
process in order to prevent resource exhaustion.

Select Domain Policies Application Rules from the left side menu as shown below. In the sample
configuration, a single default application rule “default” was used. For field deployment create an
application rule with the concurrent sessions purchased.

6.4.2.1 Application Rule for SP

Clone the Application Rule default with a descriptive name e.g. SP-AR for service provider and
click the Edit button to change value of Maximum Concurrent Sessions and Maximum Session
Per Endpoint to 500 respectively as shown and then click the Finish button (not shown). Others are
left as default.

Session Border Controller for Enterprise AVAYA

Dashboard
Administration

Application Rules: SP-AR

Add Filter By Device... -

Rename H Clone ” Delete ]

Packup/Restore

Application

Click here to escription.
ST e lick here to add a description

" Global Parameters

Application Rule

Application Rules

Border Rules

Audio

Video

[

Global Profil i
u obal Frofies

. 3 S— - Maximum Concurrent  Maximum Sessions
" PPM Services s Application Type In o Sessions ' Per Endpoint —
¥ Domain Policies EN-AR

500

500

6.4.2.2 Application Rule for EN

Similarly, clone the Application Rule default with a descriptive name e.g. EN-AR for IP Office and
click the Edit button to change value of Maximum Concurrent Sessions and Maximum Session
Per Endpoint to 500 respectively as shown and then click the Finish button (not shown). Others are
left as default.

Session Border Controller for Enterprise AVAYA

Dashboard
Administration

Application Rules: EN-AR

Add Filter By Device... -

Rename ” Clone H Delete ]

Backup/Restore

Application

Click here to escription.
System Management o lick here to add a description

* Global Parameters

Application Rule

_ SP-AR
> Global Profiles
. _ . - Maximum Concurrent  Maximum Sessions
> PPM Services RIW-AR Application Type LS s ' Per Endpu:uint“ "
4 Domain Policies EN-AR
o Audio 500 500
Application Rules
Border Rules Video B E=
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6.4.3. Media Rules

Media rules can be used to define RTP media packet parameters, such as prioritizing encryption
techniques and packet encryption techniques. Together these media-related parameters define a strict
profile that is associated with other SIP-specific policies. You can also define how Avaya SBCE
must handle media packets that adhere to the set parameters.

To clone a Media Rule, navigate to Domain Policies > Media Rules. With default-low-med rule
chosen, click Clone button.

6.4.3.1 Media Rule for SP

In this compliance testing, Secure Real-Time Transport Protocol (SRTP, media encryption) is not
supported by SP. Therefore, default-low-med rule is used for communication between Avaya SBCE
and SP.

6.4.3.2 Media Rule for EN

Secure Real-Time Transport Protocol (SRTP, media encryption) is used between Avaya SBCE and
IP Office. Therefore, it is necessary to create a media rule to apply to the internal interface of Avaya
SBCE, EN. Created EN-SRTP-MR rule is shown below.

Session Border Controller for Enterprise AVAYA
Dashboard Media Rules: EN-SRTP-MR

Administration Add |Fi|ter By Device... v| Rename Clone Delete
Backup/Restore ;

Systemn Management Media Rules Click here to add a description.

> Global Parameters ke R 1o Encryption || Codec Prioritization || Advanced || QoS |

> Global Profiles EM-SRTP-MR

Audio Encryption

> PPM Services

4 Domain Policies SRTP_AES_CM_128_HMAC_SHA1_32

Preferred Formats SRTP_AES_CM_128_ HMAC_SHA1~&0

Application Rules RTP
Border Rules Encrypted RTCP |
Media Rules

. MK |
Security Rules
Signaling Rules Lifetime Any
End Point Palicy Interworking
Groups

Session Policies

Video Encryption

> TLS Management

Preferred Formats RTP
> Device Specific Settings
Interworking O
Miscellaneous
Capability Negotiation |
Edit
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6.4.4. Endpoint Policy Groups

The rules created within the Domain Policy section are assigned to an Endpoint Policy Group.
The Endpoint Policy Group is then applied to Server Flow defined in Section 6.5.4.

Endpoint Policy Groups were separately created for SP and EN.

To create a policy group, navigate to Domain Policies - Endpoint Policy Groups and click on the

Add Group button (not shown).

6.4.4.1 Endpoint Policy Group for SP
The following screen shows SP-PG created for SP.

Set Media Rule to default-low-med.

Set Border Rule to default.
Set Security Rule to default-med.

Set Application Rule to SP-4R which was created in Section 6.4.2.1.

Set Signaling Rule to SP-SR which was created in Section 6.4.1.1.

Session Border Controller for Enterprise

4 Domain Policies Policy Groups: SP-PG
Application Rules

Add | [Filter By Device... >

Border Rules

AVAYA

Rename Clone Delete

Media Rules Policy Groups Click here to add a description.

Security Rules defaut-low Hover over a row to see its description.

Signaling Rules default-low-enc —‘

i 3 Policy Group

End Point Policy default-med

Groups Summary

Session Policies default-med-enc = == ; —

Order Application Border Media acurity Signaling
> TLS Management EN-PG
default- :

" Device Specific Settings s SP-AR default i defaulttmed  SP-SR Edit
6.4.4.2 Endpoint Policy Group for EN
Similarly, the following screen shows policy group EN-PG created for EN.
Session Border Controller for Enterprise AVAYA
4 Domain Policies Policy Groups: EN-PG

Application Rules Add [ Filter By Device... ~| Rename Clone Delete

Border Rules

Media Rules Policy Groups Click here to add a description.
- default-low ) o
Security Rules Hover over a row to see its description.
Signaling Rules default-low-enc
End Point Policy S e
Groups Summary
Session Policies Sl med one - _— . ) —
Order Application Border Media Security Signaling
- TLS Management EN-PG
> Device Specific Seftings s EN-AR default EN-SRTP-MR  default-med  EN-SR Edit
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6.5. Device Specific Settings

The Device Specific Settings feature allows aggregate system information to be viewed and various
device-specific parameters to be managed to determine how a particular device will function when
deployed in the network. Specifically, it gives the ability to define and administer various device-
specific protection features such as Message Sequence Analysis (MSA) functionality and protocol
scrubber rules, end-point and session call flows, as well as the ability to manage system logs and
control security features.

6.5.1. Network Management

The Network Management page is where the network interface settings are configured and enabled.
During the installation process of the Avaya SBCE, certain network-specific information is defined
such as device IP address, public IP address, subnet mask, gateway, etc. to interface the device to the
networks. This information populates the various Network Management tabs which can be edited as
needed to optimize device performance and network efficiency.

Navigate to Device Specific Settings > Network Management, under Interfaces tab, enable the
interfaces connecting to the inside enterprise and outside service provider networks. To enable an
interface, click on “Disable” Status. The following screen shows interface A1 and B1 were Enabled.

Session Border Controller for Enterprise AVAYA
Dashboard Network Management: mSBCE
Administration
> TLS Management
. . . Interfaces | | Networks |
4 Device Specific Settings
Network msBCE
Management
Interface Name VLAN Tag Status
Media Interface
Al Enabled
Signaling Interface
End Point Flows B1 Enabled

On the Networks tab and verify the IP addresses assigned to the interfaces and that the interfaces are
enabled. The following screen shows the private interface was assigned to A1 and the public
interface was assigned to B1 appropriate to the parameters shown in the Figure 1.

Session Border Controller for Enterprise AVAYA

Dashboard Network Management: mSBCE
» Global Parameters
> Global Profiles

. PPM Services Interfaces Network5|
> Domain Policies mSBCE Add
* TLS Management Gateway Subnet Mask Interface IP Address
14 Device Specific Settings
MNetwork_A1 10.10.97.129 255255255192 A1 10.10.97.178 Edit Delete
MNetwork
Management
Media Interface Network_B1  10.10.98.97 265255255224 B1 10.10.98.103  Edit Delete
Signaling Interface
QT; Reviewed: Solution & Interoperability Test Lab Application Notes 47 of 56

DS mm/dd/yyyy ©2016 Avaya Inc. All Rights Reserved. TLSIPO10SBCE71



6.5.2. Media Interface

The Media Interface screen is where the media ports are defined. The Avaya SBCE will open
connection for RTP traffic on the defined ports.

To create a new Media Interface, navigate to Device Specific Settings > Media Interface and
click on the Add Media Interface button (not shown).

Two separate Media Interfaces are needed for both the inside and outside interfaces. The following
screen shows the Media Interfaces InMedia and OutMedia were created for the compliance testing.

Note: After the media interfaces are created, an application restart is necessary before the changes

will take effect.

Dashboard
Administration
Backup/Restore
System Management
> Global Parameters
Global Profiles

> PPM Services

> Domain Policies

5

Session Border Controller for Enterprise

Media Interface: mSBCE

Media Interface

AVAYA

m5BCE

Modifying or deleting an existing media interface will require an application restart before taking

effect. Application restarts can be issued from System Management.

Add

» TLS Management Name N‘E':d;f = Port Range
< Device Specific Settings ' 10.10.97.176 !
InMedia e 35000 - 40000 Edit Delete
Network Management D i)
Media Interface OutMedia Ll L 35000-40000  Edit Delete
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6.5.3. Signaling Interface

The Signaling Interface screen is where the SIP signaling port is defined. The Avaya SBCE will
listen for SIP requests on the defined port.

To create a new Signaling Interface, navigate to Device Specific Settings - Signaling Interface
and click on the Add button.

Two separate Signaling Interfaces are needed for both inside and outside interfaces. The following
screen shows the Signaling Interfaces InsideSIG and OutsideSIG were created in the compliance
testing with TLS/5061 and UDP/5060 respectively configured for inside and outside interfaces.

Session Border Controller for Enterprise AVAYA
Dashboard Signaling Interface: mSBCE
Administration
Backup/Restore —‘
Si ling Interf
System Management HREIngE S
I m SBCE
> Global Parameters Modifying or deleting an existing signaling interface will require an application restart before
> (Global Profiles taking effect. Application restarts can be issued from System Management.
F PPM Services Add
> Domain Policies
> TLS Management Name Signaling 1P TLS Profile
4 Device Specific Settings
InsideSIG gl B 5061 EN-SP Edit Delet
FHEE — |-, ele
Metwork Management nside 33“@%‘;“1 (A1, i elete
Media Interface
—_ _ 10.10.98.103 _
Signaling Interface OutsideSIG m:_m (B1, - 5083 - None Edit Delete
End Point Flows
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6.5.4. End Point Flows - Server Flow

When a packet is received by the Avaya SBCE, the content of the packet (IP addresses, URIs, etc.) is
used to determine which flow it matches. Once the flow is determined, the flow points to a policy
which contains several rules concerning processing, privileges, authentication, routing, etc. Once
routing is applied and the destination endpoint is determined, the policies for this destination
endpoint are applied. The context is maintained, so as to be applied to future packets in the same
flow. The following screen illustrates the flow through the Avaya SBCE to secure a SIP Trunk call.

“Call Server® : “Trurk
Podicy Group Server Policy
! Group
“Call Server” “Trunk"Policy
G Fldlw Grm G ﬁrwp G G

In the compliance testing, two separate Server Flows were created for SP and EN.

IP-PRX

AP Trunk Service Prosader
T

To create a Server Flow, navigate to Device Specific Settings > End Point Flows, select the
Server Flows tab and click on the Add Flow button (not shown). In the new window that appears,
enter the following values while the other fields were kept as default.
e Flow Name: Enter a descriptive name.
e Server Configuration: Select Server Configuration created in Section 6.3.3 which the
Server Flow associates to.
e URI Group: Select “*”,
e Received Interface: Select the Signaling Interface created in Section 6.5.3 which is the
Server Configuration is designed to receive SIP signaling from.
¢ Signaling Interface: Select the Signaling Interface created in Section 6.5.3 which is the
Server Configuration is designed to send the SIP signaling to.
e Media Interface: Select the Media Interface created in Section 6.5.2 which is the Server
Configuration is designed to send the RTP to.
¢ End Point Policy Group: Select the End Point Policy Group created in Section 6.4.4.
¢ Routing Profile: Select the Routing Profile created in Section 6.3.5.
o Topology Hiding Profile: Select the Topology Hiding profile created in Section 6.3.6 to
apply toward the Server Configuration.
e Use default values for all remaining fields. Click Finish to save and exit.
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Flow Mame

Server Configuration

URI Group

Transport

Remaote Subnet

Received Interface
Signaling Interface

Media Interface
Secondary Media Interface
End Point Palicy Group
Routing Profile

Topology Hiding Profile
Signaling Manipulation Script

Remaote Branch Office
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The following screen shows the Server Flow SP-SF for SP.

Edit Flow: SP-SF

InsideSIG

OutsideSIG ~

OutMedia

* I *
<
< < £
< <

Mone

[sP-pg

EN-RP
SP-TH
Mone

Any

I
< <

Finish
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Similarly, the following screen shows the Server Flow EN-SF for IP Office.

Flow Name

Server Configuration
URI Group
Transport

Remote Subnet
Received Interface OutsideSIG e
Signaling Interface InsideSIG

Media Interface InMedia

]

Secondary Media Interface None

<]

End Puoint Policy Group \ EN-PG

Routing Profile SP-RP
Topology Hiding Profile EN-TH
Signaling Manipulation Script Mone

Remote Branch Office

i
5
=2
¢
<
< {

Finish
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7. Liechtenstein SIP Trunking Configuration

Liechtenstein is responsible for the configuration of Liechtenstein SIP Trunking service. The
customer will need to provide the IP address used to reach the IP Office at the enterprise, this
address will be the outside interface of the Avaya SBCE. Liechtenstein will provide the customer the
necessary information to configure the Avaya IP Office SIP connection to Liechtenstein. The
provided information from Liechtenstein includes:

IP address of the Liechtenstein SIP proxy.

Supported codecs.
DID numbers.

8. Verification Steps

IP addresses and port numbers used for signaling or media through any security devices.

The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start - Programs - IP Office > System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP line of interest from the left
pane. On the Status tab in the right pane, verify that the Current State is Idle for each
channel (assuming no active calls at present time).

AVAYA

Help Snapshot LogOff Exit About

SIP Trunk Channel Licenses:
SIP Trunk Channel Licenses in Use:
SIP Device Features:

IP Office System Status

SIP Trunk Summary 2l
Line Service State: In Service
Peer Domain Name: ipt. telenor.com
Resolved Address: 10,10,97.176
Line Number: 4
Number of Administered Channels: 10
Number of Channels in Use: ]
Administered Compression; G711 A, G711 Mu
Enable Faststart: Off
Silence Suppression: Off
Media Stream: Best Effort
Layer 4 Protocal: TLS

= @
0

REFER (Incoming and Outgoing]), UPDATE (Incoming and Outgoing)

Channel U... Call Current Timein Remote Co... Conn... Caller Other Party Directi... Round Receive Receive Trans... Trans...
Number Ref State State  Media ... IDor ... on Cal Trip... Jitter Pack..
1 Idle |00:00... -~
2 Idie |00:00...
3 Ide |00:00... v
Trace Trace Al Pause Ping Call Details Graceful Shutdown Force Out of Service Print...
Save As...
_L07:52PM |  Online
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e Select the Alarms tab and verify that no alarms are active on the SIP line.

AVAYA

IP Office System Status

Status  Utilization Summary Alarms

Alarms for Line: 4 SIP ipt.telenor.com

Line: 2 Last Date Of Error Occurrences Error Description
Line: 3
»

Line: 19

Ping Clear Clear all Graceful Shutdown Force Qut of Service Print... Save As...

Cnline

e Verify that a phone connected to PSTN can successfully place a call to the IP Office with
two-way audio.

e Verify that a phone connected to IP Office can successfully place a call to the PSTN with
two-way audio.

e Using a network sniffing tool e.g. Wireshark to monitor the SIP signaling between the
enterprise and Liechtenstein. The sniffer traces are captured at the public interface of the
Avaya SBCE.

9. Conclusion

The Liechtenstein SIP Trunking passed compliance testing with any observations/limitations
detailed in Section 2.2. These Application Notes describe the procedures required to configure the
SIP connection between Avaya IP Office, Avaya Session Border Controller for Enterprise and the
Liechtenstein SIP Trunking service as shown in Figure 1.
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Additional Avaya IP Office information can be found at:
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php? XMLFILE=manuals.xml
&TEMPLATE=pdf feed template.html

Product documentation for Avaya products may be found at http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/

Product documentation for Liechtenstein SIP Trunking is available from Liechtenstein.
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